
Conversion Information for Microsoft Word for Windows 6.0 
Supplemental File Conversions Disk

This document provides information about limitations and options when converting to and from a number
of file formats. Also included is information about conversion options you can set through the 
EditConversionOptions macro and information about font-mapping files. 
For complete installation instructions, see the cover letter that accompanied these disks and the File 
Conversion topic of the Word Readme Help file. To view this topic, double-click the Word Readme Help
icon in Program Manager and then choose the File Conversion topic on the Contents screen.
This document contains information about converting files created in the following file formats:

· DisplayWrite versions 4v1, 4v2, and 5.0 (import only)

· Lotus 1-2-3 versions 2.x and 3.x (import only)

· Microsoft Multiplan versions 3.x and 4.2 (import only)

· Microsoft Word for MS-DOS Glossary Conversion (import only)

· Microsoft Word for Windows version 1.x (only required for export)

· Microsoft Works for MS-DOS

· Microsoft Works for Windows version 2.0

· MultiMate 3.3, MultiMate Advantage, MultiMate Advantage II, and MultiMate 4.0

· WordStar 3.3, 3.45, 4.0, 5.0, 5.5, 6.0, and 7.0 

This document also contains information about importing graphics from the following formats:
· AutoCAD DXF (DXF)

· AutoCAD plotter files (ADI)

· CorelDRAW 3.0 (CDR)

· HP Graphics Language (HP-GL) / HP Plotter Print files (PLT)

· Kodak Photo CD (PCD)

· Lotus 1-2-3 graphics (PIC)

Most conversion limitations are listed in table format. The features are organized by type of formatting: 
character, paragraph, column, page, table, or document. The tables do not list features that are converted 
completely. Only features that are not converted, are not supported in one product or the other, or require 
some comment appear in the tables. "Yes" means the feature exists in both products and is converted 
from one product to the other. "No" means it exists in both products but is not completely converted 
between the two. "N/S" means the feature is not supported in one of the products or is not converted 
completely between products.
For an explanation of file converters and the procedures for opening files in other file formats, see 
Chapter 26, "Converting File Formats," in the Microsoft Word for Windows User's Guide. For 
information on converting several files at once with a supplied macro, see “CONVERT.DOT” in the 
Supplied Macros topic of the Word Readme Help file.

Conversion Limitations

Converting from DisplayWrite to Microsoft Word 6.0
The converter functions in one direction only. Data may be brought in from DisplayWrite files, but not 
saved in DisplayWrite format.
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Feature DisplayWrite to Word 6.0 Comments
Character Formatting
Color No Converted to black text.
Font No All fonts are mapped to Courier New. 

Sizing is approximated.
Hidden text N/S Hidden text is converted to DisplayWrite 

normal text.
Hyphenation See comment Required and optional hyphens convert to 

normal hyphens.
Character Mapping See comment All EBCDIC characters that have an 

equivalent character in Windows convert to
Word 6.0. Non-supported characters 
convert as the "@" character.

Small caps N/S
Strikethrough/overstrike See comment Overstrike becomes strikethrough.
Superscript/subscript See comment Superscripts and subscripts appear 6 pts 

above and below the main text line, 
respectively.

DisplayWrite Typestyles 
4069-6139

No These typestyles convert to Courier New 
and default point size.

Paragraph Formatting

Borders (double, single, 
shadow, and shading)

N/S

Hanging indents See comment Simulated with tabs and indents
Keep with next No
Keep lines together No
Space before/after 
paragraphs

See comment Simulated with blank lines.

Section Formatting DisplayWrite has no section formats.
Headers/footers No First page headers or footers are converted 

to odd page headers or footers.
Line numbering No
Section breaks N/S

DisplayWrite page breaks are converted as 
page breaks.

Columns No

DisplayWrite flowing, balanced, and 
flowing-balanced text columns convert to 
full-width, single-column document 
paragraphs.

Document Formatting
Footnotes See comment Custom footnote numbering converts to 

automatic numbering and the default 
separator is used.

Widow control No Widow control is not maintained.
Other Features
Annotations N/S Annotations convert to footnotes.
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Cross-references and 
bookmarks

N/S

Graphics No
Index See comment

Appearance is maintained in conversion to 
normal text.

Linedraw Yes DisplayWrite linedraw characters are 
formatted as MS LineDraw font.

Merge codes/Print Merge No
Outlining See comment Appearance is preserved. Outlines are 

converted to indents.
Page number Yes Page numbers are converted, but not page 

number formatting.
Tables of contents See comment Appearance is maintained in converting to 

normal text.
User defined controls No
Voice notes No

Converting from Lotus 1-2-3 2.x and 3.x to Microsoft Word 6.0
The converter functions in one direction only. Data may be brought in from Lotus 1-2-3 files, but not 
saved in Lotus 1-2-3 format.
Feature (from Lotus 1-2-3 to 
Word only)

Comments

Formatting
Font All Lotus 1-2-3 data becomes 10-point Courier font.
Numeric formatting Lotus 1-2-3 will try to fit numbers in General format into the current 

column width. When converted, these numbers are brought in at their full 
precision. You may see more decimal places in Word 6.0 than you did in 
your worksheet. 

Worksheet Size
Less than 32 columns A table is created in Word 6.0.
More than 32 columns or 
wider than 22 inches

The worksheet is represented in Word 6.0 as tab-delimited text.

Other
Ranges The converter displays a dialog box asking you to choose from a list of 

range names. Type in a Lotus 1-2-3 range (b2..g43) or choose an existing 
range name (my_data), or press ENTER to convert the entire worksheet.
Note that 3-D range names are supported correctly, but explicit 3-D range 
definitions (e.g., a:a1..c:c5) are not supported.

Password If the worksheet is password protected, you will be asked to enter the 
password. Note that you may have to reenter the password when 
beginning a print merge operation. Password-protected files created in 
Lotus 1-2-3 version 3.x cannot be converted.

Empty files Empty worksheets are imported into Word 6.0 as a single empty cell.

Converting from Multiplan 3.x and 4.2 to Microsoft Word 6.0
The converter functions in one direction only. Data may be brought in from Multiplan files, but not saved
in Multiplan format.
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Feature (from Multiplan to 
Word 6.0 only)

Comments

Formatting
Fill Not supported in Multiplan.
Color Colors and border colors are not converted.
Shading pattern Not supported in Multiplan.
Row height Rows take on the height of the cell in that row that contains the most data.
Column width Most rows retain column width. Hidden columns and zero-width columns 

become a standard width.
Regular Multiplan formats Multiplan will try to fit numbers in general format into the current column

width. When converted, these numbers are brought in at their full 
precision. You may therefore see more decimal places than you did in 
your worksheet.

Worksheet Size
Less than 32 columns A table is created in Word 6.0.
More than 32 columns or 
wider than 22 inches

The worksheet is represented in Word 6.0 as tab-delimited text.

Other
Ranges The converter displays a dialog box asking you to choose from a list of 

range names. Type in a Multiplan range (b2..g43) or choose an existing 
range name (my_data), or press ENTER to convert the entire worksheet.

Password If the worksheet is password protected, you are asked to enter the 
password. You may have to reenter the password when beginning a print 
merge operation.

Empty worksheets Empty worksheets are imported into Word 6.0 as a single empty cell.

Converting Word for MS-DOS Glossaries
Word 6.0 does not convert Word for MS-DOS glossary entries when opening a Word for MS-DOS 
document. Word for MS-DOS glossary files must be converted separately, using a two-part macro 
conversion described in the following procedure.

To convert a Word for MS-DOS glossary

1. Open a glossary file in Word for MS-DOS. Since you cannot use the mouse during the macro, 
you should move the conversion glossary files (60CONVRT.GLY, 55CONVRT.GLY, and 
50CONVRT.GLY) from the TEMPLATE subdirectory of your Word for Windows program 
directory (for example, C:\WINWORD\TEMPLATE) into the same directory as the glossary file
you intend to convert; this will make keyboard input easier. Do one of the following, depending 
on which version of Word for MS-DOS you are using:
· In Word for MS-DOS version 6.0, choose Glossary from the Edit menu, and then choose 

Open Glossary. Select the glossary file 60CONVRT.GLY then choose the OK button. 
Choose Close to close the Glossary dialog box.

· In Word for MS-DOS version 5.5, choose Glossary from the Edit menu, and then choose 
Open Glossary. Select the glossary file 55CONVRT.GLY and then choose the OK 
button. Choose Close to close the Glossary dialog box.

· In Word for MS-DOS version 5.0, choose Glossary Load from the Transfer menu, select the 
glossary file 50CONVRT.GLY and then press ENTER.

2. In an empty Word for MS-DOS document, type convert_glossary and then press F3.
3. In the Merge Glossary dialog box, type the drive, directory, and filename of the glossary file you

want to convert in the File Name box and then press ENTER.
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4. In the Glossary dialog box, type the filename of the glossary file you want to convert in the 
Glossary Name box and then press ENTER.
 Word converts the glossary file, and then stores it in the same directory as the glossary file you 
converted. The file is stored with the same name as the orginal glossary file with the filename 
extension .CVT.
When prompted to end the macro, press ENTER.
When you exit Word for MS-DOS, be sure to choose No when prompted to save the 
CONVRT.GLY file.

5. Start Word for Windows.
6. From the File menu, choose New.
7. From the Template list, select MSWORD, and then choose the OK button.
8. From the File menu, choose Open, and then specify the location and name of the file with 

the .CVT extension. To list files with a .CVT extension, type *.cvt in the File Name box, and 
then press ENTER.

9. Word for Windows asks if you want the converted AutoText (glossary) entries to be available 
globally to all documents or only to documents based on a particular template. Select the 
appropriate option, and then choose the OK button.
If you choose to make the AutoText entries available only to documents based on a specific 
template, the macro asks you for a template filename. Type a new name, or type or select an 
existing template name, and then choose the OK button. Word prompts you to supply document 
summary information. Choose OK; the Word for MS-DOS glossary entries are transferred to the 
Word for Windows template you specified.

Converting From Microsoft Word for Windows 6.0 to Microsoft Word for 
Windows 1.x

Feature Word 6.0 to 
Word 1.x

Comments

Character Formatting
Superscript/Subscript N/S This property is emulated with raised/lowered.
Kerning N/S
All caps No All caps not supported in Word 1.x as a character format.
Color See comment Dark colors in Word 6.0 are converted to Auto in Word 

1.x.
Language No Language as a property is not supported in Word 1.x.
Strikethrough See comment Strikethrough is converted to Word 1.x as revision marks.
Document Formatting Yes Mirror Even/Odd Pages is converted as a document 

format only. Page setup as a section format does not exist
in Word 1.x. As a result, the first mirror even/odd page 
settings in Word 6.0 are used for Word 1.x.

Paragraph Formatting
Borders, shading See comment Word 6.0 has more border options than Word 1.x. Word 

6.0 borders are mapped to the closest approximation in 
Word 1.x. Shading is not converted.

Section Formatting
Margins (mirror, gutter) No Not converted as section formatting. Page setup as a 

section format does not exist in Word 1.x. As a result, the
first margins in Word 6.0 are the only margins that are 
converted to Word 1.x.

Page (orientation, 
dimension, and widow 
control)

No Not converted as section formatting.
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Feature Word 6.0 to 
Word 1.x

Comments

Other Features
Absolute-positioned objects See comment In Word 6.0 these are called frames. Some properties of 

frames don't exist in Word 1.x positioned objects and are 
lost when converting from Word 6.0

Cell borders, shading See comment Word 6.0 has more border options than Word 1.x. Word 
6.0 borders are mapped to the closest approximation in 
Word 1.x. Shading is not converted.

Linked and embedded 
objects

See comment The last result of linked or embedded objects is retained 
when converting to Word 1.x.

SYMBOL field No When converting to Word 1.x, the SYMBOL field 
instruction is included in the document but has no current
result and cannot be updated.

Drawing Layer N/S
Bullets/Numbering Yes Automatic bullets and numbering are converted to plain 

text.
Variable Width Columns N/S Variable-width columns are converted to equal width 

columns.
Table Row Headers N/S These are not repeated on succeeding pages.
Footnotes/Endnotes N/S Footnotes and endnotes are retained, although they are 

merged into one continous stream.

Converting Between Microsoft Word 6.0 and Microsoft Works for MS-DOS
Feature Word 6.0 to

Works for
MS-DOS

Works for
MS-DOS to
Word 6.0

Comments

Paragraph Formatting
Tabs Tab leaders for default tabs in Works are 

not converted in Word.
Bullets and Numbering See 

comment
N/S Bullets and numbering are converted to 

plain text.
Section Formatting
Headers/footers See 

comment
See 
comment

To be converted, headers and footers must 
be located at the beginning of the Works 
document. Works headers are converted to 
a single paragraph in Word.

Even/odd special See 
comment

See 
comment

Works does not have different right and 
left headers. If one of the two is present in 
a Word document, it is preserved in the 
Works document. If right and left headers 
are both present, the latter of the two is 
preserved.

Tables See 
comment

N/S Table cells in Word are converted to 
sequential paragraphs in Works.

Other Features
Frames See 

comment
N/S Framed objects are vertically positioned 

when converted to Works.
Annotations See 

comment
N/S Annotations are converted to footnotes in 

Works.
Footnotes (manual 
reference marks)

See 
comment

See 
comment

Only the first character of a user-defined 
footnote reference mark is converted in 
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Feature Word 6.0 to
Works for
MS-DOS

Works for
MS-DOS to
Word 6.0

Comments

Works. Automatic footnotes are converted.
Graphics No No
Styles See 

comment
N/S Styles are converted to direct formatting in 

Works.
Outlining No N/S Outline structure is lost when converting to

Works.
Tables of contents, indices, 
tables of authority 

See 
comment

See 
comment

Generated tables of contents and indexes 
are converted. TC (Table of Contents 
Entry) fields are not converted.

Font Mapping

Because a particular word processor’s fonts are dependent on the installed printer drivers, fonts may not 
be translated perfectly when converting to and from Microsoft Word 6.0. You can control the font 
translation of Works for MS-DOS files by using the font-mapping file RTF_WWP.TXT, which is 
included on the Supplemental File Conversions disk. The font-mapping file overrides the default font 
mapping made by the Word 6.0 converter.
To use RTF_WWP.TXT, rename its filename extension to .DAT and move it to the same directory as the
converter. To customize the file, open it in Word and follow the instructions contained in the file itself.

Converting Between Microsoft Word 6.0 and Microsoft Works for Windows 2.0

Note
You can open Works for Windows 3.0 files directly in Word. When opening Works for Windows 3.0 
files in Word, first make sure that the Confirm Conversions checkbox is selected in the Word Open 
dialog box (File menu). When you open the Works for Windows 3.0 file, the Convert From dialog box is 
displayed. Select Works For Windows 3.0 in the list of file formats and choose the OK button.

Feature Word 6.0 to 
Works

Works to 
Word 6.0

Comments

Character Formatting Changed to plain text format in Works for 
Windows if format is not supported.

All caps, small caps, 
hidden, and color

No N/S

Outline, shadow N/S N/S
Underline (dotted, double, 
word)

See 
comment

N/S Works for Windows supports only single, 
continuous underlining.

Spacing (condensed, 
expanded)

No N/S

Columns No N/S
Document Formatting
Footnotes See 

comment
See 
comment

Footnotes are always at the end of the 
document in Works for Windows.

Summary info No N/S
Widow control No See 

comment
This feature is automatic in Works for 
Windows.

Page Formatting
Margin (gutter), mirror 
even/odd pages, page 
orientation, paper source

No N/S

Paragraph Formatting
Background shading, No N/S
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Feature Word 6.0 to 
Works

Works to 
Word 6.0

Comments

numbering
Borders Yes Yes Thin, thick, and double borders are 

converted properly. Unsupported border 
styles become thin line borders.

Page break before See 
comment

N/S This format is converted to hard page 
breaks in Works for Windows.

Tabs See 
comment

Yes Negative tabs are not allowed in Works for
Windows.

Section Formatting Works for Windows does not have section 
formatting. Many properties related to 
sections in Word 6.0 become document 
properties in Works for Windows.

Section breaks (even, odd, 
continuous, next page)

No N/S Section breaks are converted to page 
breaks in Works for Windows.

Headers/footers See 
comment

See 
comment

Headers and footers are document 
properties in Works for Windows. 
Even/Odd Special is not converted. First 
Page Special in Works for Windows only 
offers options of no header or footer on 
first page.

Line numbering No N/S
Restart page number at one No N/S
Vertical alignment (top, 
centered, justified)

No N/S

Tables No N/S Tables are converted to tab-delimited text 
in Works for Windows.

Other Features
Frames No N/S
Annotations See 

comment
N/S Annotations are converted to footnotes in 

Works for Windows, retaining the page 
number reference.

Endnotes No N/S
Footnotes See 

comment
See 
comment

Numbering of footnotes is different in the 
two products. Works for Windows counts 
manual footnote entries in the numbering 
sequence, whereas Word 6.0 counts these 
separately.

Footnote starting number, 
separators, continuation 
notices, restart each section

No N/S Footnotes always start with 1 in Works for 
Windows.

Footnote position (end of 
page, end of document)

No N/S Notes are always endnotes in Works for 
Windows and appear at the end of the 
document.

Graphics (cropping) No N/S
Drawing Layer No N/S
Styles No N/S Word 6.0 styles are converted to direct 

formatting in Works for Windows.
Outlining No N/S
Revision marks No N/S
Tables of contents, indexes,
tables of authorities

See 
comment

N/S The tables are converted to text-result only 
in Works for Windows.

Print Merge commands No No Merge fields are converted, but data 
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Feature Word 6.0 to 
Works

Works to 
Word 6.0

Comments

(logic, data files) documents are not automatically 
converted.

Date/time stamps (custom), 
page number (format, 
restart), subdocuments 
(INCLUDE field) 

No N/S

Cross-references/ 
bookmarks

See 
comment

Yes Bookmarks are not allowed in a Word 6.0 
header or footer. Bookmarks in these areas 
are lost.

Fields (equations, formulas,
links, form fields, bar 
codes)

No N/S Field results are brought in where possible 
when converting from Word 6.0 to Works 
for Windows.

Object linking and 
embedding (OLE)

Yes Yes Word 6.0 is a client for Works for 
Windows charts, MS Draw drawings, and 
Microsoft Excel charts and worksheets.

Bullets/Numbering See 
comment

N/S Automatic bullets and numbering are 
converted to plain text.

Converting Between Microsoft Word 6.0 and MultiMate
For best results, repaginate MultiMate documents before converting.
Feature Word 6.0 to 

MultiMate
MultiMate to 
Word 6.0

Comments

Character Formatting
Italic No No Italic is a separate font in MultiMate.
Shadow No No
Small caps No N/S
Draft N/S No
Strikethrough Yes See 

comment
MultiMate strikethrough is converted to 
Word’s default strikethrough character.

Enhanced N/S No
Fonts See 

comment
See 
comment

Pitch settings are converted, but fonts are 
not retained during import or export. All 
fonts are converted to Courier or Courier 
New on import conversion.

Columns
Break See 

comment
See 
comment

Section column breaks are not supported in
MultiMate. Section breaks are inserted in 
Word 6.0 for conversion of MultiMate 
columns.

Snaking See 
comment

See 
comment

Snaking columns are converted, but require
repagination in MultiMate before printing.

Space between No See 
comment

MultiMate intercolumn gaps are not 
converted.

Document Formatting
Gutter margins No N/S
Mirror Even/Odd Pages No N/S
Page Formatting Margins are offset by the width of the non-

printable area of the installed printer.
Paragraph Formatting
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Feature Word 6.0 to 
MultiMate

MultiMate to 
Word 6.0

Comments

Right and justified 
alignment

No No

Borders No N/S
Indents See 

comment
N/S Negative indents are not converted.

Keep lines together No No
Keep with next paragraph No No
Line spacing See 

comment
Yes Fractional line spacing is rounded off to the

next half-line increment. MultiMate zero, 
quarter, and half line spacing are converted
to single line spacing in Word.

Space before/after para See 
comment

N/S Line spacing before and after paragraphs is
converted to empty paragraphs of 
equivalent increments.

Tabs (center, right, and tab 
leader)

No N/S

Tabs (decimal) See 
comment

See 
comment

Decimal tabs convert to left tabs.

Center part of a line N/S No
Section Formatting
Section breaks See 

comment
N/S Column, even, and odd breaks are not 

converted.
Headers/footers No No The first header/footer encountered in a 

MultiMate document is converted. First, 
even, and odd page headers/footers are 
converted to MultiMate. MultiMate header 
and footer positions from edge become 0.5 
inch in Word.

Line numbering No N/S Section line numbering is not converted.
Tables No N/S Tables are not supported in MultiMate.
Other Features
Annotations No N/S
Footnotes Yes See 

comment
MultiMate stores footnotes in a separate 
document with a different filename 
extension. To view the footnotes converted
with a MultiMate document, make sure the
footnote file is renamed to the same name 
as the converted document and ends with 
the .FNX filename extension.

Footnote position (end of 
page, end of document)

No No

Manual footnote reference 
marks

No N/S

Graphics No N/S
Outlining No N/S Outline structure is lost when converting to

MultiMate.
AutoText/Library No See 

comment
Convert the MultiMate Library file 
separately, then select each entry in the 
converted file and copy to a new AutoText 
entry in Word.

Index No N/S
Tables of contents No See To convert a MultiMate table of contents, 
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Feature Word 6.0 to 
MultiMate

MultiMate to 
Word 6.0

Comments

comment separately convert the .TOC file, then 
insert the converted .TOC file into the 
converted main document.

Print Merge commands 
(MultiMate information 
handling files)

No No Print merge fields are not converted.

Bookmarks No N/S
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Converting between Word 6.0 and WordStar

Feature Word 6.0 to 
WordStar

WordStar to 
Word 6.0

Comments

Character Formatting Changed to plain text format in WordStar 
if feature is not available.

Small caps No N/S
Font color No Yes
Double-strike format N/S No
Space Underline N/S No
Font type styles N/S No
Document Formatting
Footnotes See 

comment
Yes Converting to WordStar, custom footnote 

numbers do not convert, and starting 
footnote reference numbers do not convert.

Page Formatting
Margins See 

comment
Yes The first margin encountered in the Word 

document is used for the entire document 
when converted to WordStar.

Gutter margins No No
Paragraph Formatting
Tabs See 

comment
Yes Converting to WordStar, vertical tab 

alignment does not convert.
Right indents No N/S
Space before and after See 

comment
N/S Converting to WordStar, space before and 

after is simulated with blank lines.
Paragraph numbering No No
Paragraph margins No No
Tabl leaders and decimal 
tabs

See 
comment

See 
comment

Tab leaders are not converted. Decimal 
tabs become left tabs.

Keep with next and keep 
together

No N/S

Section Formatting
First page special 
header/footer

No N/S

Date and time entries in 
footers

No N/S

Even/odd headers/footers No No
Headers/Footers general See 

comment
See 
comment

More than 3 lines of header/footer text 
does not convert to WordStar. Paragraph 
formatting in headers/footers does not 
convert.

WordStar default page 
number in a footer

N/S No

Tables See 
comment

N/S Tables are converted to tab-delimited text 
in WordStar.

Other Features
Styles See 

comment
See 
comment

Styles are converted only for WordStar 
version 5.5 and above. From WordStar to 
Word 6.0, styles are converted to direct 
formatting.

Table of contents No See To retain the appearance of a WordStar 
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Feature Word 6.0 to 
WordStar

WordStar to 
Word 6.0

Comments

comment table of contents, convert the .TOC file 
separately, then insert it into the converted 
WordStar document that is associated with 
it.

Index No See 
comment

To retain the appearance of a WordStar 
index, convert the .IDX file separately, 
then insert it into the converted WordStar 
document that is associated with it.

Tables of captions, tables of
figures, tables of authorities

No

Outline No No
Page Numbers See 

comment
See 
comment

Non-numeric page numbers and page 
position are not converted.

Print Merge No No
“Dark” and “Light” colors N/S See 

comment
Converted to Black.

Printer control codes N/S No
Orientation No No
Summary info No No
Place markers N/S No
Overprinting N/S No

Conversion Options in the EditConversionOptions Macro
You view and change the options for some converters using the EditConversionOptions macro, which is 
available in the CONVERT.DOT template. CONVERT.DOT can be found in the MACROS subdirectory 
of the Word program directory. 

To run the EditConversionOptions Macro:

1. Open the CONVERT.DOT template. You can open the template by using the Templates command
(File menu) to load the template as a global template or by choosing the Open command (File 
menu) to open it directly.

2. From the Tools menu, choose Macro.
3. Select EditConversionOptions in the Macro Name list.
4. Choose the Run button.
5.  Follow the instructions on the screen.

Graphics Filters Information

AutoCAD DXF Graphics
The AutoCAD DXF graphic import filter supports AutoCAD versions through version 12. AutoCAD 
version 11 includes a feature that enables the user to place special borders around the drawing. When 
these borders are imported, the converter overlaps the borders and graphics. To import such drawings, 
remove the borders or send the file through the ADI plotter to a plot file, then import the resulting plot 
file directly into Word for Windows.
This filter has the following limitations:

· Extrusions, which are related to 3-D entities, are not supported.
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· Control codes and special characters (except underlining) embedded in text shapes require 
special characters and are not supported.

· DXF files requiring separate shape definition files are not supported.
· For multiple viewport DXF files, the file is imported using the current viewport.

AutoCAD ADI Binary Plotter Files
The Word for Windows 6.0 AutoCAD ADI graphic import filter, ADIMPORT.FLT, supports binary 
plotter file output from all versions of AutoCAD (up to and including version 12) via the Autodesk 
Device Interface (ADI).
The ADI Binary graphic filter can be used to import any image saved in the ADI format, including 3-D 
images with a viewport selected.
Since ADI files only refer to pen number without specifying what color each pen is, all pens are assumed 
to be black. Thus, all images will be black and white.

Exporting ADI Binary Graphics from AutoCAD

In AutoCAD, you can configure one pen plotter and one printer plotter device at one time. 

To configure for export

1. From the AutoCAD Main menu, select option 5 (Configure AutoCAD).
2. From the Configuration menu, select option 5 (Configure Plotter).
3. Select ADI Plotter.
4. Select Output Format option 1 (Binary file).
5. You can accept the default settings for the questions that follow, or you can consult your printer 

manual to optimize the plotter specifications for your output device. When you leave AutoCAD, 
be sure to choose Yes when asked if you want to retain your configuration settings.

After you configure the AutoCAD ADI plotter interface, you can export the graphic in one of two ways:
· You can plot an existing drawing file to a file by selecting option 3, Plot a drawing, from 

AutoCAD's Main menu. When asked to specify a filename, make sure to include an .ADI 
filename extension (the default extension is .PLT).

· You can plot the current drawing to a file by entering the PLOT command from the AutoCAD 
Drawing Editor. When asked to specify a filename, make sure to include an .ADI filename 
extension (the default extension is .PLT).

The AutoCAD image is now ready to be inserted into a Word 6.0 document.

CorelDRAW 3.0
This filter has the following limitations:

· Rotated rounded rectangles are emulated using Circular Arc Center.
· Vector Pattern fills are not fully supported.
· Envelope editing and perspective editing are not supported.
· Bitmaps are not supported.
· Extruded object groups are not fully supported.
· OLE Objects are not supported.
· Line scaling is not supported.

HP-GL
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This filter supports all HP-GL/2 kernel commands as specified in Hewlett Packard's The HP-GL/2 
Reference Guide - A Handbook for Program Developers. It supports HP-GL/2 command extensions as 
supported by the HP7595 Draft Master. To ensure best results when importing HP-GL/2 files into Word, 
configure your application to create commands suitable for a 7595 Draft Master plotter. This filter 
supports display of color images and assumes the following pen color set:

Pen Number Color
Pen 1 Black
Pen 2 Red
Pen 3 Green
Pen 4 Yellow
Pen 5 Blue
Pen 6 Magenta
Pen 7 Cyan
Pen 8 Orange

This filter has the following limitations:
· Polyline Encoding is not supported.
· Color Table commands are not supported.

Kodak Photo CD
By default, this filter imports images at a resolution of 512 x 768 pixels in 256 colors. Use the following 
procedure to change the default resolution. 

 To set the default resolution.

1. From the File menu in Program Manager, choose Run.
2. In the Command Line box, type notepad.exe win.ini and then choose the OK button. This will 

open WIN.INI in Notepad.
3. If there is not already an [MS Photo CD Import Filter] section in WIN.INI, create one.  Position 

the insertion point below all the text in the file and type [MS Photo CD Import Filter].
4. In the [MS Photo CD Import Filter] section, add the following line, where N is the default 

resolution you want to use: 
DefaultResolution=N
The default resolution can be any number between 0 (zero) and 8.  The resolutions represented 
by these numbers are listed in the two tables following this procedure.
You should use the smallest number possible for your output.  A larger number means a higher 
quality image, but slower printing and display in Word or any other application.

5. From the File menu in Notepad, choose Save and then Exit.

The following resolutions support 256 colors (8 bit). The quality of the images is lower, but they display 
and print more quickly.

Default resolution number Resolution

0 512 x 768 (default)
1 128 x 192 (small picture)
2 256 x 384
3 1024 x 1536
4 2048 x 3072 (large picture)
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The following resolutions support 16.7 million colors (24 bit). The quality of the images is very high, but 
they display and print very slowly.

Default resolution number Resolution

5 512 x 768 (small picture, high 
quality)

6 128 x 192
7 256 x 384
8 1024 x 1536 (large picture, 

high quality)

PIC
This filter supports PIC files created by Lotus 1-2-3 and and Borland Quattro Pro.
It does not support Micrografx PIC or Draw Plus PIC.

_____________________________________________________________________

Microsoft, MS, MS-DOS, and Multiplan are registered trademarks and Windows is a trademark of Microsoft 
Corporation.

1-2-3 is a registered trademark of Lotus Development Corporation.
AutoCAD is a registered trademark of Autodesk, Inc.
Corel is a registered trademark  of Corel Systems Corporation.
DisplayWrite is a registered trademark of International Business Machines Corporation.
HP and HP-GL are registered trademarks of Hewlett-Packard Company.
Kodak is a registered trademark of Eastman Kodak Company.
MultiMate is a registered trademark of Borland International, Inc.
WordStar is a registered trademark of WordStar International Incorporated.
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